Printing User Barcodes From
Symphony

Or

The Reason We Like Library
Cards



In “Schedule New Reports” select “Print Barcodes” Tab

@lSirsiDyniu Symphony WorkFlows

File Edit Wizards Helpers Modules Preference Tools Window Help

Common Tasks

[E Report Session /

Templates Print Barcodes |

% Schedule New Reports

% Scheduled Reports Report name = Source
Finished Reports Lit Unused Barcodes fr‘eetuaru:u:ujes
Print Copy Barcodes (Batch) barcodeitem
@ Itern Search and Display Print Copy Barcodes (Single) barcodebyitern
Print User Barcodes (Batch barcodeuser
Check Itern Status ! ( . :
Print User Barcodes (Single) barcodebyuser

Help




Choose “Print User Barcodes (Batch)”

ESirsiDyniu Symphony YorkFlows

File Edit Wizards Helpers Modules Preference Tools Window Help

‘Cataloging | Circulation | Offline  Reports | Requests | Utility

Schedule New Reports : Display Template Reports

Common Tasks

Report Session

Templates Print Barcodes
'@ Schedule New Reports

% Scheduled Reports Report name * Source
Firibed] Bt LIS-t Unused Barcodes freebarc_udes

Print Copy Barcodes (Batch) barcodeitemn
% Itern Search and Display Print Copy Barcodes {Single) barcodebyitem

Print User Barcodes (Batch) harcodeuser

Check Itern Status

Help

Print User Barcodes (Single) barcodebyuser




Click on Setup and Schedule
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File Edit Wizards Helpers Modules Preference Tools Window Help
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Schedule New Reports : Display Template Reports

Common Tasks

Repaort Session

Templates Print Barcodes
% Schedule New Reports

% Scheduled Reports Report name »

Source
Fisfhed) Remare List Unused Barcodes freebarcodes
Print Copy Barcodes (Batch) barcodeitern
% Itern Search and Display Print Copy Barcodes (Single) barcodebyitern
Check Ttem Status F'rnt User Barcodes I{E-atn::h]l barcodeuser
Print User Barcodes (Single) barcodebyuser
Help

Setup &

Schedule e
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Common Tasks

Report Session

% schedule New Reports
% Scheduled Reports
Finished Reports

% Itern Search and Display

Check Item Status

Help

Schedule New Reports : Schedule Print User Barcodes (Batch)

Basic | Group ID| User Selection | User Status Selectionl Sor‘tingl

Repart name: [Qilngl

Description: IGenerate user barcode label
Title: |User Barcode

Footer:l

= [E

Schedule

Run Mow (b}

Sawe As Template

Cancel




Copy Name or Change Description and Title
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Schedule Mew Reports : Schedule Print User Barcodes (Batch)

Common Tasks

Basic | Sroup IDI User Selection | User Status Selectionl Su:ur‘tingl
Report Session

@ Schedule New Reparts

Report name: IWiIIuw Elementary Grade 1
% Scheduled Reports

Cescription: | ade
Finished Reports Title: IWiIIuw Elementary Grade 1
Footer: I

% Itern Search and Display
Check Item Status

Help




Choose User Selection Tab

ESirsiDynix Symphony WorkFlows

File Edit Wizards Modules Preference Tools Window Help

Schedule New Reports : Schedule Print User Barcodes [Batch)

Common Tasks

Basicl Group 10 User Selection | User Status Selectinnl Snr‘tingl
Report Session

@ Schedule New Reports Llhrar\,r:l ®
User prafile: |

% Scheduled Reports

User category 1. | @

Finished Reports User categaory 2:| %
@ Itern Search and Display lUser category 3:| &
Check Itern Status User category 4: I ®
%

Help User category 5: |




Begin Filtering Criteria — This is the ONLY way to get small groups of user barcodes

SirsiDyni:-: Symphony WorkFlows
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Schedule New Reports : Schedule Print User Barcodes (Batch)

Common Tasks

_ Basicl Group 10 User Selection | User Status Selectionl Snr‘tingl
] Report Session

Library:l

@] Schedule Mew Reports @
User profile: |
% Scheduled Reports

$ .
Choose your library code - the
User category 1. I ® . .
Finished Reports Voo ety 24| & Gadget has a list of all library
@ Itern Search and Display User category 3;| & COdes in alphabetical Order
@ Check Ttern Status User category 4: I ®
&

Help User category 5: I




Highlight your library code and double click or click on the arrow to move the code to
the right hand box

(1| SirsiDynix Symphony WorkFlows
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Schedule New Reports : Schedule Print User Barcodes (Batch)

Common Tasks

Ba Gadget : Library - 0 =
rTg Report Session

' Includ lected polici
'E] Schedule New Reports ISR Belleiat [

" Excludes selected policies

% Scheduled Reports o }
Us ' Contains invalid policy

Finished Reports s © Contains no policy
@ Itern Search and Display Us  Lict to choose from List selected

Us T
@ Check Item Status LIBBLIND d

Help Us L-RESEARCH
MILLARDEKM

MULTICOBEM
ONLIME

PANGUITCH  "
RICHBKM

RULES =|
RULES —
G ]

SANIUANBKM
SANPETEBKM

JELEBK
TRICOBKM
/ upoT

usL

USL_GP
UTAHCOBKM
ZDEMO =

QK | Cancel |




When the library name is in the right hand box click on “OK”

File Edit Wizards Modules Preference Tools Window Help

Schedule New Reports : Schedule Print User Barcodes (Batch)

Common Tasks

Ba Gadget : Library = O
Report Session
% Schedule New Reports & Includes selected policies

" Excludes selected palicies
% Scheduled Reports o ) )
Us " Contains invalid policy

Finished Reports us  Contains no policy

% Item Search and Display Us  —list to choose from List selected
Check Itern Status Us II:IHBBLIND ﬂ TOOELEBKM «
Help Us L-RESEARCH

MILLARDBKM

MULTICOBEKM

OMNLINE

PAMGUITCH

RICHBEKM |

RULES =

SANIUANBKM Q:ll

SANPETEBKM

TOOELEBKM
TRICOBKM
uooT
UsL
UsL_GP
UTAHCOBKM
ZDEMO =

QK | cancel |




Using the gadgets, enter in the other parameters for the group whose barcodes you
need to print (Willow Elementary, 1st Grade in Grantsville)
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File Edit Wizards Modules Preference Tools Window Help

Cataloging | Crculsion | ffins _Reports | Reaussts | Uity

Schedule New Reports : Schedule Print User Barcodes (Batch)

Common Tasks

Basic| Group ID User Selection | User Status Selection] Sorting|

Report Session
@ Schedule Mew Reports Hlororre ITOOELEE'KM @
% el " ser profile:l &

cheduled Reports

N User category 1: [GRANTSWILL | The Symphony code for the school
Finished Reports e @
12 e S v il User category 3| ® \The Symphony code for the grade
@ Check Itemn Status User category 4: I &
Help User cateqgary 5: | &




Move to the “Sorting” tab and choose the sort order for your report
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Schedule New Reports : Schedule Print User Barcodes (Batch)

Common Tasks

Basicl Group IDI User Selectinnl User Status Selection Snr‘tingl
Repaort Session

% Schedule New Reports Stz by Iuser 1D j

% Scheduled Reports user name

Finished Reports

% Itern Search and Display

ﬁ? Check Itern Status

Help




Choose when you want the results of the report

@SirsiDyniH Symphony WorkFlows

File Edit Wizards Modules Preference Tools Window Help

Catalging | Circlation | Offine _fports | Requests | Uiy

Common Tasks

Report Session

@ Schedule New Reports
% Scheduled Reports
Finished Reports

% Itern Search and Display

i‘ir‘ Check Item Status

Help

Schedule New Reports : Schedule Print User Barcodes (Batch)

Basic' Group ID| User Selection | User Status Selection Sor‘tingl

Sorted by:luser name j / Chosen sorting Ol‘der

Schedule - runs at night or other non-busy times

Please do not set up a template
for each school/grade

Run now - somewhat immediate
gratification - report runs and
Is in finished reports

Run MNow (b) Saye As Template | Cancel |




Choices when you schedule a report — (ASAP is same as “run now”) the other choices will give
options on when you want the report to run
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W

Schedule New Reports : Schedule Willow Elementary Grade 1

Common Tasks

Report name; Willow Elermentary Grade 1
& report session =chedule

% Schedule Mew Reports

¢ once 0 Daily © weekly ¢ Monthly

% Scheduled Reports
Finished Reports Printing/Distribution

% Itemn Search and Display B Send e p Arier I jv I Format ASAP - aka Run NOW

¥ Save to Finished Reports Wizard

[~ Email to Individual(s) | & ¥ Format

Feply to:l j

@ Checl Itern Status

Help

Click on “Schedule”

Schedule Change format | Cancel |




Where do you want to go when this report is scheduled?

@SirsiDyniH symphony WorkFlows
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Cataloging | Cireuation | Offine_fzports | Requests | tity_

Schedule New Reports : Schedule Willow Elementary Grade 1

Common Tasks

Rep Schedule New Reports = B
rﬁ Report Session S
Frequency: ASAP

i) Schedule New Reports  Mext run date: D4/14/2010,13:53

Last run date:
% Scheduled Reports .

Printer:

Finished Reports B Email to:

[" Do not email notices to recipients with email addresses

% Itern Search and Display Suspended:

F e
|"|J" Check Itemn Status Pla.c:e o it 7
[T Notify owner: Y
Help View type: Both result and log

Schedule a Display
Mew Report Scheduled Reports

Display

Finished Reports Elase

\I will go to finished reports

Schedule Change format | Cancel |




If your report is not near the top of the finished reports list check the “Display Report

Scheduler Status” Helper

SirsiDynix Symphony WorkFlows - |E|
File Edit Wizards Helpers Modules Preference Tools Window Help ﬁSisiDyn
Schedule New Reports : Display Finished Reports = &

Common Tasks

r'?g Report Session

% Schedule New Reparts
% Scheduled Reports

[ Finished Reports

@ Itern Search and Display

@ Check Item Status

Help

Display Report Scheduler Status Helper

Report name | Source | Status

Print Uset

rmue The Display Status Helper will either show a report
rituser Name (the beginning of the name very brief) or a box

Print Uset

mnue that says “The report scheduler is currently

‘=2 running. There are no reports running.” If you get

Print User

rrtizer this message and you can’t see your report click on

Print Uset

rcuse the “Refresh Reports List” Helper (magic bunny in

" hat), this will bring any recently finished reports
Print Uset into the list.

Print Uset
Print User Barcodes (Batch) - TS - ROSESPRINGS- 1 barcodeuser Ok
Meink Hoow Oovondes fO0-boht TT TOARAH - non-student barcodeuser QK

Refresh Reports List Helper *** E— oK

APAH-6th barcodeuser ak

Completed «

4/14/2010,14 ;00 &
4/14/2010,11:39
4/14/2010,11:39
4/14/2010,11:39
4/14/2010,11:39
4/14/2010,11:39
4/14/2010,11:38
4/14/2010,11:38
4/14/2010,11:38
4/14/2010,11:38
4/14/2010,11:38
4414/2010,11:37
4/14/2010,11:37
4/14/2010,11:37
4/14/2010,11:37
4/14/2010,11:37
4/14/2010,11:36
4/14/2010,11:36
4/14/2010,11:36

Frint User Barcodes (Batch) - TI- IBAPAH-5th barcodeuser QK 4/14/2010,11:36
Print User Barcodes (Batch) - TI- IBAPAH-dth barcodeuser QK 4/14/2010,11:36
Print User Barcodes (Batch) - TI- IBAPAH-3rd barcodeuser Ok 4/14/2010,11:35
Print User Barcodes (Batch) - TI- IBAPAH-2nd barcodeuser Ok 4/14/2010,11:35
Print User Barcodes (Batch) - TI- IBAPAH-1st barcodeuser Ok 4/14/2010,11:35
Print User Barcodes (Batch) - TG-Willow-3 barcodeuser QK 4/14/2010,11:35
Print User Barcodes (Batch) - TG-Willow-2 barcodeuser QK 4/14/2010,11:35
Print User Barcodes (Batch) - TG-Willaw-1 barcodeuser 1’4 4/14/2010,11:34
Frint User Barcodes (Batch) - TGrantsville - non-student barcodeuser QK 4/14/2010,11:34
Print User Barcodes (Batch) - TGrantsville - éth barcodeuser QK 4/14/2010,11:34
Print User Barcodes (Batch) - TGrantsville - 5 barcodeuser QK 4/14/2010,11:34
Print User Barcodes (Batch) - TGrantsville - 4 barcodeuser QK 4/14/2010,11:33
Print User Barcodes (Batch) - TGrantsville - 3rd barcodeuser Ok 4/14/2010,11:33
Print User Barcodes (Batch) - TE - EXCELSIOR - ns barcodeuser Ok 4/14/2010,11:33
Print l1srr Rarcndes (Rateh’ - TF - FXCFISTOR - A harrndriser (814 44450101135 2
iew | Brint Ermail {b) | Remove... Ownership {g) | Close




The report that is running may not be the one you told to run now - and it may take
some time to run - you will have to be patient.

%

\!‘) The report scheduler 1s currently running.

List Bibliography 4/14/2010,14:16

You have no indication of who you can complain about running the report, so it
doesn’t help to complain.




Now you can see your report — click on hat.

Display Status ﬂ

1 The report scheduler 15 currently running.
N) There are no reports running.




Remember the name of your report? If you didn’t change the name of the report you
might end up with many with the same name and no idea which is which.

5irsiDyni:H: Symphony WorkFlows

File Edit Wizards Helpers Modules Preference Tools Window Help

Cataloging | cirlaion | Offne _Fesorts | Requests | Uity

Finished Reports : Display Finished Reports

Common Tasks Default name for this report

Report Session
Finished |

% Schedule Mew Reports

% Scheduled Reports RWme | Source | Status |

Firfihod Fapens Print User Barcodes (Batch)‘ barcodeuser
Willow Elermentary Grade 1 barcodeuser

&g Itern Search and Display Print User Barcodes (Batch) - Tw- WENDOVER - non-student barcodeuser
Print User Barc (Batch) - Tw ith - K barcodeuser

@ Check Itern Status -
Print User Barcodes (Batch) - TW-SMITH - & barcodeuser

Help Frint User Barcodes (Batch) - Twi-SMITH - 5 barcodeuser
Frint User Barcodes (Batch) - Tw-SMITH - 4 barcodeuser
Print User Barcodes (Batch) - TWi-SMITH - 3 barcodeuser
Print User Barcodes (Batch) - Tw - Smith - 2 barcodeuser
Print User Barcodes (Batch) - TW-Smith - 1 barcodeuser
Print User Barcodes (Batch) - TS - ROSESPRIMNGS- non student barcodeuser
Print User Barcodes (Batch) - TS - ROSESPRINGS- 6 barcodeuser
Print User Barcodes (Batch) - TS - ROSESPRIMNGS- 5 barcodeuser
Print User Barcodes (Batch) - TS - ROSESPRINGS- 4 barcodeuser
Frint User Barcodes (Batch) - TS - ROSESPRINGS- 3 barcodeuser
Print User Barcodes (Batch) - TS - ROSESPRINGS- 2 barcodeuser
Print User Barcodes (Batch) - TS - ROSESPRINGS- 1 barcodeuser
Frint User Barcodes (Batch) - TI- IBAPAH - non-student barcodeuser
Print User Barcodes (Batch) - TI- IBAPAH-K barcodeuser
Frint User Barcodes (Batch) - TI- IBAPAH-Ath barcodeuser
Print User Barcodes (Batch) - TI- IBAPAH-Sth barcodeuser
Print User Barcodes (Batch) - TI- IBAPAH-4th barcodeuser
Print User Barcodes (Batch) - TI- IBAPAH-3rd barcodeuser
Print User Barcodes (Batch) - TI- IBAPAH-Znd barcodeuser
Print User Barcodes (Batch) - TI- IBAPAH-1st barcodeuser
Print User Barcodes (Batch) - TG-willow-3 barcodeuser
Print User Barcodes (Batch) - TG-willow-2 barcodeuser
Frint User Barcodes (Batch) - TG-willow-1 barcodeuser
Frint User Barcodes (Batch) - TGrantsville - non-student barcodeuser
Print User Barcodes (Batch) - TGrantsville - 6th barcodeuser

1 ] Mermd I lmmee O mpemm o =~ O =k B e TV R | C | I .




Information in the list of finished reports.

SirsiDynix Symphony WorkFlows - |I:I|5|
File Edit Wizards Helpers Modules Preference Tools Window Help ﬁsrsiDynlx

Gtaoging! e Cine_resorts [Reaiess| Uiy

A - Di o ° °
— Finished Reports : Display Finished Reports Completed IS the tlme your =)=
L]
. report finished - can be
;] Report Session
% schedule Mew Reports Finishes | IMPORTANT l
% Scheduled Reports ‘Repor‘t name Source | Status | Completed «
Finished Reports Print User Barcodes (Batcl barcodeuser [ol'4 4/14/2010,14:32 & |
Willow Elementary Grggé 1 barcodeuser [o]'¢ 4/14/2010,14:00
@ Item Search and Display Print User Barcades/{Batch) - Tw- WENDOVER - non-student barcodeuser [s]14 4/14/2010,11:39
Check Ttsm Status F'rnt User l::-arn::r.njes (Batch) - TW - Smith - K g
Print User Bafcodes (Batch) - TW-SMITH - & barcodeuser oK 4/14/2010,11:39
Help Print Usgf Barcodes (Batch) - TW-SMITH - 5 barcodeuser 39
PrintMser Barcodes (Batch) - TW-SMITH - 4 barcodeuser Status Will indicate if there 39
BNt User Barcodes (Batch) - TW-SMITH - 3 barcodeuser ° ° b
Print User Barcades (Batch) - TW - Smith - 2 barcodeuser were prOblems in runnlng your L]
. codeuser report 8
Report name is from the top box on xdeusr o
sodeuser [ol's 4/14/2010,11:38
the first tab of your report odsuser o 4420101137
Print User Barcades (Batch) - TS - ROSESPRINGS- 4 barcodeuser [o]4 4/14/2010,11:37
Print User Barcodes (Batch) - TS - ROSESPRINGS- 3 4/14/2010,11:37
Print User Barcodes (Batch) - TS - ROSESPRINGS- 2 Source is the “file name” of the report 4/14/2010,11:37
Print User Barcodes (Batch) - TS - ROSESPRINGS- 1 0] 4/14/2010,11:37
Print User Barcodes (Batch) - TI- IBAPAH - non-student scrlpt that creates your report 4/14/2010,11:36
Print User Barcades (Batch) - TI- IBAPAH-K barcodeuser [o]4 4/14/2010,11:36
Print User Barcodes (Batch) - TI- IBAPAH-6th barcodeuser QK 4/14/201&11:36_
Print User Barcodes (Batch) - TI- IBAPAH-5th barcodeuser QK 4/14/2010,11:36
Print User Barcodes (Batch) - TI- IBAPAH-4th barcodeuser [o]'¢ 4/14/2010,11:36
Print User Barcodes (Batch) - TI- IBAPAH-3rd barcodeuser [o]'¢ 4/14/2010,11:35
Print User Barcades (Batch) - TI- IBAPAH-2nd barcodeuser [o]4 4/14/2010,11:35
Print User Barcades (Batch) - TI- IBAPAH-1st barcodeuser [o]4 4/14/2010,11:35
Print User Barcodes (Batch) - TG-Willaw-3 barcodeuser 0K 4/14/2010,11:35
Print User Barcodes (Batch) - TG-Willow-2 barcodeuser Ok 4/14/2010,11:35
Print User Barcades (Batch) - TG-Willow-1 barcodeuser [ol's 4/14/2010,11:34
Print User Barcades (Batch) - TGrantsville - non-student barcodeuser 1’4 4/14/2010,11:34
Print User Barcades (Batch) - TGrantsville - 6th barcodeuser [o]4 4/14/2010,11:34
Print User Barcodes (Batch) - TGrantsville - 5 barcodeuser QK 4/14/2010,11:34
Print User Barcodes (Batch) - TGrantsville - 4 barcodeuser QK 4/14/2010,11:33
Print User Barcodes (Batch) - TGrantsville - 3rd barcodeuser [o]'¢ 4/14/2010,11:33
Print |lser Rarrades (Rateh’ - TF - FXCFISTOR - ns harrndriser 0k 4M4mn41:a33 1
Wiew | Brint Ernail (b} | Remove... Ownership (g} | Close |




“Good” vs. “Bad”

SirsiDynix Symphony WorkFlows

File Edit Wizards Helpers Modules Preference Tools Window Help

Cetaloging | Ciralaton | Offine _Reports | Requests | Uty

Finished Reports : Display Finished Reports

Common Tasks

= g
Fieper Sossten bt | Same source file
% Schedule New Reports

% Scheduled Reports Report name Afo/c:e | Status | Comg

Finished Reports F'rllnt User Barcodes (Batch) barcodeuser / kK
Willow Elermentary Grade 1 barcodeuser Ok

% Itern Search and Display Print User Barcodes (Batch) TWSWENDTYER - non-student barcodeuser oK

[ barcodeuser

@ Check Itemn Status . - . .
Print User Barcode 7 - Ok

Help Print User Barcode What 1nformat10n does the Report oK
Print User Barcode o Ok
Print User Barcode name glve us: 0K
Print User Barcodes {Batch) - TW - Smith - 2 barcodeuser kK
Print User Barcodes {(Batch) - TW-Smith - 1 barcodeuser kK
Print User Barcodes {Batch) - TS - ROSESPRINGS- non student barcodeuser Ok
Print User Barcodes (Batch) - TS - ROSESPRINGS- 6 barcodeuser oK
Print User Bar.—..—..—lnf FR =t~k - TE - DACECODTR,TS . E Foavcmdanicar fa1rd

] (13 2

Prnt User Bar- A “Good” report name will identify the report easily
Print User Bar_ ool (Coiiin,  C cihlllivimell Ll
Print User Barcodes (Batch) - TS - ROSESPRINGS- 2 barcodeuser ik
Print User Barcodes (Batch) - TS - ROSESPRINGS- 1 barcodeuser ik
Print User Barcodes {Batch) - TI- IBAPAH - non-student barcodeuser kK
Print User Barcodes {Batch) - TI- IBAPAH-K barcodeuser kK
Print User Barcodes {Batch) - TI- IBAPAH-6th barcodeuser Ok
Print User Barcodes {Batch) - TI- IBAPAH-Sth barcodeuser Ok
Print User Barcodes {Batch) - TI- IBAPAH-4th barcodeuser Ok
Print User Barcodes {Batch) - TI- IBAPAH-3rd barcodeuser Ok
Print User Barcodes (Batch) - TI- IBAPAH-Znd barcodeuser Ok
Print User Barcodes (Batch) - TI- IBAPAH-1st barcodeuser ik
Print User Barcodes (Batch) - TE-Willow-3 barcodeuser ik
Print User Barcodes {Batch) - TG-willow-2 barcodeuser kK
Print User Barcodes {Batch) - TG-Willow-1 barcodeuser kK
Print User Barcodes {Batch) - TGrantsville - non-student barcodeuser Ok
Print User Barcodes {Batch) - TGrantsville - ath barcodeuser Ok
Print User Barcodes {Batch) - TGrantsville - 5 barcodeuser Ok
Print User Barcodes {Batch) - TGrantsville - 4 barcodeuser Ok




Now we have a finished report — where do we go from here?
[0l

File Edit Wizards Helpers Modules Preference Tools Window Help ﬁsrBiDanx

catabang | Ciedation | ofne _Reors | Reauets | ity

Finished Reports : Display Finished Reports = m| =X

Common Tasks

Report Session

Finished |
@ Schedule Mew Reports
% Scheduled Reports Report name Source | Status | Completed «
Fisfclhed R Print User Barcades (Batch) barcodeuser 1’4 4/14/2010,14:32 & |
Willow Elermentary Grade 1 barcodeuser QK 4/14/2010,14:00
@ Itern Search and Display Print Jdser Barcodes {Batch) - TW- WENDOVER - non-student barcodeuser oK 4/14/2010,11:39
Priny User Barcades (Batch) - TW - Smith - K barcodeuser [o]4 4/14/2010,11:39
@ Checl: Item Status ,
Pyt User Barcodes (Batch) - TW-SMITH - 6 barcodeuser [o]'¢ 4/14/2010,11:39
Help rint User Barcodes {Batch) - TW-SMITH - 5 barcodeuser oK 4/14/2010,11:39
Print User Barcodes (Batch) - TW-SMITH - 4 barcodeuser QK 4/14/2010,11:39
Print User Barcodes (Batch) - TWw-SMITH - 3 barcodeuser [o]'¢ 4/14/2010,11:38
Print User Barcades (Batch) - TW - Smith - 2 barcodeuser Ok 4/14/2010,11:38
Print User Barcodes (Batch) - TW-Smith - 1 barcodeuser oK 4/1442010,11:38
Print User Barcades (Batch) - TS - ROSESPRINGS- non student barcodeuser 1’4 4/14/2010,11:38
Print User Barcodes (Batch) - TS - ROSESPRINGS- 6 barcodeuser [o]'¢ 4/14/2010,11:38
Print User Barcodes (Batch) - TS - ROSESPRINGS- & barcodeuser QK 4/14/2010,11:37
. . o Ok 4/14/2010,11:37
Highlight the report you want to see or work with o 4/14/2010,11:37
FIIL USEl DarsuuEs \Dattil) = 13 = RUSCIFRLNGS- & uarsuueuser Ok 4/14/2010,11:37
Print User Barcodes (Batch) - TS - ROSESPRINGS- 1 barcodeuser QK 4/1442010,11:37
Print User Barcades (Batch) - TI- IBAPAH - non-student barcodeuser QK 4/14/2010,11:36
Print User B: . ° barcodeuser Ok 4/14/2010,11:36
Print User B: CIICk on “Vlew” barcodeuser a4 4/14/2010,11:36—
Print User Barcodes (Batch) - TI- IBAPAR-Sth barcodeuser QK 4/14/2010,11:36
Print User Barcodes (Batch) - TI- IBAPAHMth barcodeuser [o]'¢ 4/14/2010,11:36
Print User Barcodes (Batch) - TI- IBAPAH-3Xd barcodeuser oK 4/14/2010,11:35
Print User Barcodes (Batch) - TI- IBAPAH-2Zn barcodeuser QK 4/1442010,11:35
Print User Barcades (Batch) - TI- IBAPAH-1st barcodeuser 1’4 4/14/2010,11:35
Print User Barcades (Batch) - TG-Willow-3 barcodeuser Ok 4/14/2010,11:35
Print User Barcodes (Batch) - TG-Willow-2 barcodeuser a4 4/14/2010,11:35
Print User Barcades (Batch) - TG-willaw-1 barcodeuser [o]4 4/14/2010,11:34
Print User Barcodes (Batch) - TGrantsville - non-stu barcodeuser [o]'¢ 4/14/2010,11:34
Print User Barcodes (Batch) - TGrantsville - 6th barcodeuser oK 4/14/2010,11:34
Print User Barcodes (Batch) - TGrantsville - 5 barcodeuser QK 4/14/2010,11:34
Print User Barcodes (Batch) - TGrantswille - 4 barcodeuser [o]'¢ 4/14/2010,11:33
Print User Barcodes (Batch) - TGrantsville - 3rd barcodeuser 414 4/14/2010,11:33
Print llser Rarcndes (Rateh’ - TF - FXCFISTOR - ne harcndeisrr K df44201n.11 :fﬂj
Yiew Print Email (b} | Remove... | Ownership (g} | Close




How you view a report depends on what is in the report.

bl
File Edit Wizards Modules Preference Tools Window Help @SYBiDyrix
Finished Reports : Display Finished Reports =0 x
CommonTasks (8 BNV 1 =il |
i Finished Reports : View Finished Reports
Report Session
i Report to view: Willow Elemnentary Grade 1
% Schedule Mew Reports [ view Ing
% Scheduled Reports N ¥ View result |
Finished Reports ﬁ ¥ Format report ’;
% Itern Search and Display Pr 42111:
Check Item Status E: :;2212:11:3
Help Pr Some reports, give all of the information in the log. Others 4/2010,11139
P ° ° ° ° 4/2010,11;39
o give a summary of the query behind the report in the log. Still 4/2010,11:30
i others give some of the helpful information both in the log and [/
Pr in the result. For the “Print User Barcodes (Batch)” report you 4/2010,11:38
P ° ° 4/2010,11:38
o will usually only want to see the result - without the format. 4/2010,11:37
Pr 4/2010,11:37
Pr 4/2010,11:37
Pr 4/2010,11;37
Pr 4/2010,11:37
Pr 4/2010,11:36
Pr 4.-"’2010,11:36_
Pr 4/2010,11:36
Pr 4/2010,11:36
Pr 4/2010,11:36
Pr 4/2010,11:35
Pr 4/2010,11:35
Pr 4/2010,11:35
Pr 4/2010,11:35
Pr 4/2010,11:35
Pr 4/2010,11:34
Pr 4/2010,11:34
Pr 4/2010,11:34
Pr 4/2010,11:34
Pr 4/2010,11:33
Pr 4/2010,11:33
LIEY ai7n1n.11:33 %
Change format | Cancel |




Remove the check from both the “View log” and the “Format report” boxes and click

on “OK”

5| SirsiDynix Symphony WorkFlows I [m]
File Edit Wizards Modules Preference Tools Window Help gmw
W
Finished Reports : Display Finished Reports - 0O x
Common Tasks ¥I = ==l : =
-+. Finished Reports : ¥iew Finished Reports
I—|E Report Session |
Fin Report to wiew: Willow Elernentary Grade 1
% Schedule New Repaorts (] Wi (g
% Scheduled Reports ¥ view result |
[ Finished Reports 4/2010,14:32 2
@ Itern Search and Display Pr 4/2010,11:39
@ Check Item Status E: :i;gigiizz
Help Pr 4/2010,11:39
I Pr 4/2010,11:39
Pr 4/2010,11:38
Pr 4/2010,11:38
Pr 4/2010,11:38
Pr 4/2010,11:38
Pr 4/2010,11:38
Pr 4/2010,11:37
Pr 4/2010,11:37
Pr 4/2010,11:37
Pr 4/2010,11:37
Pr 4/2010,11:37
Pr 4/2010,11:36
Pr 4/2010,11:36
Pr 4/2010,11:36
Pr 4/2010,11:36
Pr 4/2010,11:36
Pr 4/2010,11:35
Pr 4/2010,11:35
Pr 4/2010,11:35
Pr 4/2010,11:35
Pr 4/2010,11:35
Pr 4/2010,11:34
Pr 4/2010,11:34
Pr 4/2010,11:34
Py 4/2010,11:34
Pr 4/2010,11:33
Pr 4/2010,11:33
i 4f?ﬂ1ﬂ.11:33j
oK Change farmmat | Cancel |




Your report contains 1) user barcode - 2) library name - 3) user name - THAT IS ALL

=[0I ]

File Edit Wiew Insert Format Help

D@ Sl & F=@lo]

IEourierNew j |1EI j IWeslern j Bl]lg 5 = gl =

TART OF DATA -
E&DZQEDDEEEDEQlTOOELEBKHlA., HAHCNEY BRIANNE| File name of report on your computer
24029000065004 | TOOELEEKH| ALTENREID, ASHLYNN M. |
24020000065012 | TOOELEEKH| ANDERSON, GAGE L. |
24025000065020| TOOELEEKM| ANDERSCN, JOSHUA L. |

24029000065954 | TOOELEBKH| ANDERSCN, KENNEDIE| ) . .
2402900006503 | TOOELEBKM| ANDERSON, OLKLEY D.| Information in report — barcode, library name, and

24029000065046 | TOOELEEEM| ANGELD, LARAMIE L.| User name separated by a pipe (I)
24029000065053 | TOCOELEEEN| ANTHCNY, TYTUS L.|

£4029000065061| TOOELEEEM| ARAVE, MYRLNDL R.|
2402900006507 | TOCELEEEM| ARNOLD, ALEXIS I.
£40230000650587| TOOELEBEM | BARLOW, EBURGUNDT |
£4023000065095| TOOELEEEM| BARTLETT, STEVEN E. |
24029000065103 | TOOELEEEM| BARTLEY, HALLE H.|
£4025000065111| TOOELEBEM | BEARD, EMILY R.|
£4023000065129| TOOELEEEM| BEGLY, HADLEE]
24029000065137| TOOELEEEM| BERGENER, BRAYDEN T.|
£4023000065145| TOOELEEBEM| BERTOT, DANTCN C.|
£4025000065152 | TOOELEBEM| BIRD, WHITNEY R. |
24029000065160| TOOELEEEM|BITTER, CLARIZSL R.|
£4029000065175| TOOELEBEM| ELEAZARD, MARCUS G. |
£40230000655962 | TOOELEBEM| BOT3CHAROW, ALANNL|
24029000065970| TOOELEEEM| BOUTCHYARD, LIBERTY|
£40290000651586 | TOOELEBEM| EOWLES, KADEN H.|
£40250000651594| TOOELEEBEM| BROADEENT, AU3TIN L.|
£4029000065202 | TOOELEEEM| BROWN, DAXTCN R. |
240290000652 10| TOCELEBEM| EROWN, STEVIE|
£4023000065225 | TOOELEBEM| BULLOCK, ALRCN J.|
2402900006523 6| TOOELEEEM| EUTLER, CHLOE N. |
24029000065244 | TOOELEEEM| BUTLER, 3EYLER O.|
£4025000065251| TOOELEBEM | CARTER, ODIN E.| _J

AAOTOOANAOSEY S0 T TT PR COT AT WTNLNA ™M |

For Help, press F1




From .txt report to scanable Excel

Save the Symphony file to your computer with a name and location you will

remember
Only a gopher wants to look for this (or a geek wannabe)

_ 2 x|

Save i IE}tmp j J ? o "

E] view_akznl2302085345766544 17 kxt

N

Has no meaning to humans

Desktop

Y

by Documents

W
-

tdy Computer

File name: |--H akznl 2302085348 7665447 7 b j Save I
j Cancel |
s

Save as type: I Text Document

[~ Savein this format by default




Change directory, rename and save

_. Dezktop

Save i

T~

= Q@ & 2 -

E )My Docurnents
i o A 5} Mw Compuber

by Recent "HM':.# Mebwork, Places

SRS MARC utilities
) Shortcuts
E:}rﬂ':.-' Docurnents

by Documents

o B

by Computer

File harme:

Save asz lype:

Rename

Change directory

Save

willowelennl =t

Text Dacurent

[ Sawve in thiz format by default

L4 [

Save

Cancel




On Beyond .txt

e To be able to create scanable barcodes we have to import the file
from Symphony into Excel.

[ have created a template which will help with the formatting of the
Excel file and also contains the formula and font that you need for
the barcode.

e At the end of this presentation I will give the path for both the
template (.xlt file) and the font (.otf file). You will need to have both
on your computer to start the next step.

 [This feels like doing taxes, a list of what you have to have to do
what you need to do.]

e If you have not gotten the template and font where they need to be
give me a call and I'll try to help.

e Now on with the show --



After the Preparation is Done ...

=10/ x|

 Fle Edt Wiew Insert Format Tools Data  ‘Window  Help Type a question for help +

EHRSGRI VA swRa-¥/9-c-az-i @@ Heli T I Hs U=

] S| 6 % ||T|-_"'J | ¥ Reply with Changes... End Review. .,
|'| en In Contribute ﬁFuhh sh To \Website ost To Blog ! @':I:II’I'-."EEH: PDF m Create PDF _'% @ !

i%! Q.J!

Open Excel (and close the blank spreadsheet if it automatically opens)
Click on File>New

EIZZl[al.-'-.l* g |ﬁ\gtu:-':'-|'|a|:ue~_:v N w1 I|j 4 i @ .| &y

Ready UM



Get the Template

E3 Microsoft Excel -0 x|
) Type a question for help -
; u = & - A

© Fle  Edit Insert  Format Data W

NEEHRSBAIVE s RR-¥IY

‘mtteawE 5 % @ By A | verepl wih Changes... EndReview..,
st To E:h:u;l - & ] convert POF 7] Create POF ) 5‘]!

Open In Contribute EF‘utuli:'-h To Websit

mElal

Mew Workbook

Templates
Seatch online For;

ETRTE

Recently used template

we B | Agoshapes~ N\ N (DO E 4 s @ RERRT R




Templates [There are more here than in most computers]

Templates

General | Spreadshest Solutions |

never-ckod, xlk new-titles, <k non-carren,..  olc-excepki...

ophl.xlk Print_User_... Set_up.xlt  upload_tem...

@_u\ \ Choose your Template (Prin

upload_tem... Click on “OK”

LTS T AT
i

A3 o

e [e=|

— Preview

Prexiews nok available,

. User_Barcodes.xlt)

Templakes on Office Cnline

Ik I Cancel




Get Data File (your Symphony .txt file)

E Microsoft Excel - Print_User_Barcodes1 =10 x|
@_] File Edit Wiew Insert Format Tools Data  Window  Help Type aquestionforhelp » _ & X

DEHRISGQAIVE & @ 9018 -4 % @lnﬂ%v@! Canbria -0 - |B I U|E==qHE &,éva
% E S S S| @ Ey gE | YeReply with O
B open In Contribute F'ublish To Website Pust Tao Blag! @Cunv

es... End Rewview..,

OF 7 Creats FOF L&) Eﬂ!

mElial
Al - f
A B | C \ N E F G H I I
1 R n
Make sure cell Al is highlighted
[ 2 |
Click on Data>Import External Data>Import Data -
[ 3 |
[ 4 |
[ 5 |
[ 6 |
7
M 4 » mW]\Sheet1 { sheetz £ Sheets / | 4] | ﬂjﬂ

Draw = ¢ | Autoshapes- N\ % [ O & 4 2 8] [ &-évé-fﬁziﬂ!
Ready MLIM y




Loal in:

My Recent
Cocuments

Deskkop

My Documents
-
5,5

My Computer

;'!]J
My Mebwork:
Places

Locate Your Symphony .txt File

Select Data Source

) My Data Sources

w

D-2Q X

e Local Disk (C:)
\:«_} Harizon Skats (D
cge Ext Drive (E:)

=# Shared on 'Cesl\Data’ (F:)

“w Removable Disk (1:)
=% Public on 'CesliSys' (2:)
%) My Metwork Places
=l r'-“l':.f Diocuments

| MP.FLC |_|I:|I|I:|es
|3 Shorbcuts
) FTP Locations
AddModify FTP Locations

_'ﬁ Information on 'CeslDakal s, ..
_'ﬁ Rhansen on 'Cesl\DakaiUsers', .,

i v Tools -

2%

rs

Mululn

50 Sirsi-tmp
5 5tats

) Symphony _tmp

LII:ah_Lil:uraries Femoke_Acc:

Choose the directory or path to where you
saved the .txt file — mine is on my desktop

L N W W Ry T T

nn Dekail FY20074, odc

tes.igy

5.0y
=0y

El

[

Mew Source, .,

Dpen

Files of type: I.ﬁ.II Diata Sources (*,odc; *,mdb; *.n‘u:le;j

iZancel

S
Y




Remember what you called it?

Select Data Source 7] %]

Look in: (&} Deskiop j @~ 4 Q X [y - Toos-

__.__] E My Documents

:J My Compuker
My Recent [y Network Places
Documents MARC utiliies
e Shortcuts
|. My Documents
Desktop [ Fwilowelemist, bxt —

Highlight your file name

‘_) Click on “Open”

File narne: j Mew Source. ., CIpEn

My Mebwarlk,
Flaces Files of bype: | all Data Sources (*.odc; *.mdb; *.mde; j Cancel

‘_—

e




Begin Import Process

Text Import Wizard - Sktep 1 of 3 d A

The Text Wwizard has determined that wour data is Delimited.,
If this is correck, chioose Mext, or choose the daka bwpe that best describes wour daka.

riginal data kwvpe
Zhoose the File tyvpe that best describes wour data:

% iDelimited: - Charackers such as commas or kabs separate each Field.
7 Fixed width - Fields are aligned in columns with spaces between each Field.
Start import ak row: |1 = File origin: I 437 : OEM United States -

Prewview of File C:\Documents and SettingsikbansentDeskiopiwillowelem 1 sk, bxk.,

S TART OF DATA
F40Z2000066069 | TOOELEEEM | A, MAHON
F40Z9000065004 | TOOELEEKM | ALTENREID, LYNN M. |
F40Z9000065012 | TOOELEEKM | ANDERSON, CAGE
F40Z9000065020 | TOOELEEKHM | ANDERSON, JOSHUA

= 2

Zancel I = Back Mext = L Finish I

r.n|.n-r.-.1ml—-

Row 1 gives us no information — so change “Start import at row:” to 2




On to Step Two ...

Text Import Wizard - Sktep 1 of 3 d A

The Text Wwizard has determined that wour data is Delimited.,
If this is correck, chioose Mext, or choose the daka bwpe that best describes wour daka.

riginal data kwvpe
Zhoose the File tyvpe that best describes wour data:

% Delimited - Charackers such as commas or kabs separate each Field.
7 Fixed width - Fields are aligned in colurnns with spaces bebween each Field.
Stark impork akt row: Iﬁ File arigin: 437 : 2EM United States -

Prewview of File C:\Documents and Settings\rhansentDeskiopiwillowelem 1 sk, bxk,

1023000056063 | TOOELEEEM |[A. ., MAHOMNEY ERTLNNE |
A0 =23000055004 | TOOELEEEHM | ALTENRETD, ASHLTHN MN. |
4023000055012 | TOOELEEEM | AMDERSON, GAGE L. |
4022000025020 | TOOELEEEM | ANDEERSON, JOSHIOL L. |
1030000553954 | TOOELEEFM | ANDEERSON, EEMNMNEDTIE |

- mr.n|.nwrx:u

i3

Zancel I = Back Mext = I Finish

Click on “Next” and change that dialog box to match the next screenshot




Choosing the Delimiter

Text Import Wizard - Step 2 of 3

This screen lets wou set the delimiters wour data contains. You can see
how wour kext is affected in the preview below,

elimiter‘fy

[ Tab [ Semicalon

[ sSpace v Other: || .

I oM

[ Treat consecutive delimiters as one

Text gualifier: |" |

/

—Daka previews /

203000065083
02300005004
4023000055012
4023000055020
A3 000055354

TOOELEEET
TOOELEEBET
TOOELEEBET
TOOELEEBET
TOOELEEET

n ., MAHONEY EPRITARNE

L LTEMERETID |
LM ERSON
LM ERSON

LMD ERSON, EEMNMEDTIE

ASHLYTHMNI M.
CLGE L.
JOSHTA L.

L

Cancel

I = Back Mext = I Finish

—
~ |
2

Remove the check from the “Tab” box, Add a check to the “Other” box and put the
“pipe” symbol (shift-\ key) into the space after “Other” — Then click on “Next”




Remove Empty Column

Text Imporkt Wizard - Skep 3 of 3 d A

This screen lets wou select each column and sek ——aolumn data Farmat
the Daka Formak. &+ GCeneral
'‘General' conwverks numeric values to numbers, dake " Tewxt

wvalues to dates, and all remaining walues ko texk,

" Date: MDY -

7 Do not import column (skipd

adwvanced. ..

—Daka previews

Concral  Lencrgl Concrol
TOOELEEEM [o., MAHONEY ERIANNE
TOOELEEEM RBLTEMNREIL, ASHLYNN IN.
TOOELEEFEM RMNDERSON, SAGE L.
TOOELEEEM RMNDERSOMN, JOSHUTA L.
TOOELEEEM RMNDERSON, EENNEDIE - |

Cancel I = Back I Mexk = I © Finish I

Highlight the 4" (empty) column with a heading of “General”




This screen lets wou select each column and sek

the Data Formak.

Choose to Skip Column

Text Import Wizard - Step 3 of 3

% General

'‘General' conwverks numeric values to numbers, dake " Tewxt

wvalues to dates, and all remaining walues ko texk,

adwvanced. ..

£ Dake:

—_alurnn daka Farmak

MDY -

7 Do not import column (skipd

—Daka previews

Concral

Coeneral

203000065083
02300005004
4023000055012
4023000055020
A3 000055354

TOOELEEET
TOOELEEBET
TOOELEEBET
TOOELEEBET
TOOELEEET

Concral

n ., MAHONEY EPRITARNE
LW LTEMPRETID, A5HLTHIN M.
LMD ERSON, GAGE L.

LMD ERSONM, JOSHIDA L.
LMD ERSON, EEMNMEDTIE

IR

Zancel I = Back

Mext =

Change radio button from “General” to “Do not import column (skip)”




“Finish” the Import

Text Import Wizard - Step 3 of 3

This screen lets wou select each column and sek

the Daka Formak. e ererel
'‘General' conwverks numeric values to numbers, dake " Tewxt
wvalues to dates, and all remaining walues ko texk, ™ Date

adwvanced. ..

—_alurnn daka Farmak

—Daka previews

Coner ol

Concrol

203000065083
02300005004
4023000055012
4023000055020
A3 000055354

Concral

TOOELEEET
TOOELEEBET
TOOELEEBET
TOOELEEBET
TOOELEEET

n ., MAHONEY EPRITARNE
LW LTEMPRETID, A5HLTHIN M.
LMD ERSON, GAGE L.

LMD ERSONM, JOSHIDA L.
LMD ERSON, EEMNMEDTIE

LT

Zancel I = Back

Mext =

Finish

Click on “Finish”




Where do you Want Your Data to Be on the Spreadsheet

Imporkt Dakta il
Where do wou wank to puk the daka? ‘ Ik I
{* Existing worksheet:

Zancel |

Esagr %

" Mew worksheet
\

Remember cell A1?

Zreate a PivotTable repaort, ..

Properties. .. Farameters. .. Edit Guers.. .

Click on “OK”



Just a Few More Steps ....

B2 Microsoft Excel - Print_User_Barcodesi

E‘_j File Edit Wiew Insert Format  Tools Data  Window  Help
DS HR S Q| VR ¥ &5 @;- ) .- @ T -4 2] [ﬂmu% v-:gjjaicc-.mbria -10 ~| B 7 U
R - I I el e o 1= | ¥# Reply with Changes... End Review...
: E open In Contribute Publish To Website Post To Blog ! E@CDnvert FDF .ﬁCreate PDF % Eﬂ !
melal
Al -

Twpe a question Far help

=

i,
1

i

iy -

A B | c | D | E | F & H i hij K

2 4029000308408 F

1 2A029E+13|TOOELEBEM A, MAHOMEY BERIAMNMNE

2 | 2.4029E+13 TOOELEEEM ALTEMNREID, ASHLYIIM I

3 24029E+13 | TOOELEBEM ANDERSON, GAGE L.

4 | 2.4029E+13 TOOELEEKM ANDERSOM, JOSHUA L.

5 | 24029E+13 TOOELEEKM ANDERSOM, KEMNEDIE

& | 2.4029E+13 TOOELEEKM ANDERSON, OAKLEY D.

4 4 » [ Sheetl { Sheetz / Sheets /
Autoshapes = N\ [ O & 4 2 (8] & | & - - A= @ @

Ready MU

i

Draw ~  Lg

Highlight cell D1 and “copy” the cell by doing “Ctrl/C” on your keyboard, or
“Edit>Copy” on the menu bar



Copy cell ...

B2 Microsoft Excel - Print_User_Barcodesi

=1
‘&) Fle Edit Wiew Insert Format  Tools Data  ‘Window Help Type a question For belp -~ o 8
NDEEHR GRITE| % DERF| 9@ 4] L@ - .;@!ilDAutomatioana-aM -5 -|B 7 U | EE=HE »-A- E
R - I I el e o 1= | ¥# Reply with Changes... End Review...
Open In Contribute Publish To Website Post To Blog ! @Convert FOF ﬁ Create PDF % Eﬂ !
melal
&1 - B g AL 4
A | B | c b E | F & H i I K L =
w 2 4 02 9 020030 & 40 & F
1 24029E+13 TOOELEEEM A, MAHOMEY BRIAMNNE
2 24029E+13 TOOELEEEM ALTEMNREID, ASHLYDNIM IM.
3 24029E+13 TOOELEBEM AMNDERSONM. GAGE L.
4 24029E+13 TOOELEBEM ANDERSON, JOSHUA L.
5 24029E+13 TOOELEBEM ANDERSONM, KEEMMEDIE
a] 24029E+13 TOOELEEEM ANDERSOM. OAKLEY D.
4 4 ¢ M[.Sheetl { Ghestz £ Sheets 7 |« | L[J_I
! Draw g | AutoShapes = > S [ O A 42:3 &l & &'é'é'E G E " j!
Ready MU A

Move cursor to cell “D2” (D1 will still have the ‘moving’ lines around it — saying that
is the cell you are copying) now drag the highlight down to the last cell by a user
name - or scroll down and hold down the “shift” key to highlight the column --



Now for the magic!

B2 Microsoft Excel - Print_User_Barcodesi

Eﬂ File Edit Wiew Insert Format Tools Data  Window Help

D EHR SGQ VR $XEBR-F 9--@ 54| %] @100% - @ | mavonationricasM -5 < B 1 U
o I I R | ) & Bl [= | ¥¢Reply with Chanaes... End Review... !

E open In Contribute Publish To Website Post To Elog ! @Convert FOF ﬁCreate PDF 5@ Eﬂ !

RSB
(3= - #x

Twpe a question for help -

[=]= = Jy -

i,
1

A | B | c D E | F & H i hij K |

al

187 | 24029E+13 TOOELEBEM WITHERS, DAKOTA P,

185 | 2.4020E+13 TOOELEBEM 'WOLLESEN, WYATT

189 24020E+13 TOOELEBEM 'WRIGHT, NMATHAMEIL

200| 24029E+13 TOOELEEKM YAGER, THOMAS B,

201 | 24029E+13 TOOELEEKM VOUMNG, KYLEE A,

202

M 4 » m[\Sheetl / shestz £ sheet3 / [«]
Draw ~ g | AutoShapes = ™ ™ [] O 2] ﬁ{? 8] [ &‘g'é'E

Ready

LI

Now using your favorite method, paste what you have copied to all the cells in
the column that have user names (edit/paste, ctrl/V ...)



Ta Da ...

Microsoft Excel - Print_User_Barcodes1 i [=]
@J File Edit Wiew Insert Format Tools Data  Window Help Twpe a question Far help 8 x
OEHR SRS %@ S IR N SR Y @100% - @ || | DadtomationHCIsM - 8 < | B 7 U ggg = H-A-H
| | T ] '] Reply with Changes... End Rewview... B
Open In Contribute [ Publish To Website  [5F) Post To Blog = &1 Conver tPOF 5 create FOF L 5 =
=l - EeRl

o2 - A =UEAD g
A | B | c | b | E | F = H I I K L =
1 24029E+13 TOOELEBEM A, MAHOMEY ERIAMMNE
2 24029E+13 TOOELEBKEM ALTEMNREID, ASHLYINIM IV,
3 24029E+13 TOOELEBEM AMNDERSOM, GAGE L.
4 | 2.4029E+13 TOOELEEEM AMDERSOM, JOSHUA L.
5 | 24029E+13 TOOELEEKEM AMDERSOM, KEMIMEDIE
AT
& 24029E+13 TOOELEBEM ANDERSONM. OAKLEY D.

4 4 ¢ M[iSheetl { Gheetz £ Sheets 7 |« | L[J_I
Draw = li | AutoShapes~ > N [ O B Al ¢ E @ & - Z- A-==2 @ IjB

Ready MU A

BEWARE DO NOT REMOVE COLUMN “A” UNLESS ....

Column D holds a formula not the data - notice the white line above the spread-

sheet (there are the letters “fx” before it — that is the formula. If you remove
column A you would have a barcode like the one in the template all the way
down the page - (the barcode would be **).




Header - To Identify

Page Setup ?I KI
Page | Margins {FeaderiFosieri| sheet |
AM920707 43 A0 Erink...
Frinkt Preview
Header:
Cpkions. ..
4192010749 AM - =F
_uskormn Header. .. I _uskom Fooker. ..
Fooker:
Page 1 of 7 |
Fage1oF 1
ik I —ancel

Click on File>Page Setup in the menu bar...
Choose the “Header/Footer tab ...

Click on “Custom Header” ... Enter the name of the school/grade ... click on “OK” ...

and “OK” again




Custom Header

X

To Format kext: seleck the kesxt, then choose the Font bukkon,

0 4

Toinsert a page number, date, time, file path, flename, or tab name: position the

insertion point in the edit box, then choose the appropriake butkon, Cancel
Toinsert pickure: press the Insert Pickure button, To Format your pickure, place the

cursor in the edit box and press the Format Pickure button,

Al 8|6 Blo]| al8|0] &%
Left seckion: Cenker seckion; Right seckion:
Willow Elementary - 15t Grade] <] 4] d[Date]d[Time] =]

[« [« [

Enter identifying information in the left section — and click on “OK” and “OK” again
to exit the Header/Footer configuration menus. Save as an Excel file and print.




Prep Directions

PREPARATION

“By failing to prepare you are preparing to fail.”
Benjamin Franklin



http://www.telesalesmagic.com/wp-content/uploads/2009/05/preparation_mousetrap.jpg

Excel Template ...

& C:.Documents and Settings'\rhansen' Application Data'Microsoft Templates - IEllil

J File Edit Wiew  Fawvorites  Tools

Help "1"

J @Back - \‘_F:,l - L‘_ﬂ' | /.;jSEarch W Folders

T

J Address Ilji] CiDocuments and Settingstrhansenapplication Data\Microsoft) Templates - ;I a0
4| regkormal . dak @screen_shnts.dnt
File and Folder Tasks * &l All-items-out. It & et _up.xlt
@ BB =l [0 Shorbcut ko public ations

4

Other Places

¥

Details

Templates
File Folder

Date Modified: Mondayw, March
9, 7010, 5:36 PM

@ Bibscoll-loc_template, xIt @J upload_template_long. xIk
%Eﬁ This is the path for the directory that the template needs to
| live in ... C:\Documents and Settings\{your name/\Application

%m Data\Microsoft\Templates

Dlo_ooo, i

.@ﬁ;?al If the “Templates” isn’t in this path, create it as a new folder.
If.—ryFa::cc_n:u:ﬂ-.-'r.|:|-:|t

@ir

=], You might also choose the use the C:\Documents and Settings\
Ejr All Users\Application Data\Microsoft\Templates directory if

gjlﬂ more than one person will be printing barcodes

@J LOST-MISSIMNG REPORT. It
@ Lost-rnissing_damaned. x|k

El:J Lost-missing_with_barcode, xlk
@ never-ckod., x|k

@ new-titles, x|k

El,d] non-current-borrowers, <k
It.—ryr‘\\h:-rrrnal.u:I-:ut

@ olc-exception. x|t

@ ophl. =l
@Print_Llser_Barches.xlt «— Our handy template

Save the .xlt file into the Templates directory.




Open Source Font

& O WINDOWS Fonts —1O] =]
J Eile Edit Wig Favarites Tools Help | .1'
- =% - ) e
J e Eack. = lﬁ P Search ers [=a] [E25] |AB]| [==]
J address Ih‘l;'l CoWINDOWS Fonks 4 _Iv Go
Franklin Gothic  French Script Garamond Garamond Garamond Garamond... Garamond... Garamond... Gararmond. .. Gaukami *I
Medium Ikali... MT (TrueTvpe) (TrueTwvpe) Bold (Tr... Ikalic (Tr... (TrueTwvpe) (TrueTvpe) (TrueTvpe) (TrueTvpe) (TrueType)
GEOrgia Georgia Bold  Georgia Bold Georgia Ikalic Giddywupstd Gigi Gill Sans MT Gill Sans MT Gill Sans MT Gill Sans MT
(TrueTwpel (TrueTwpe) Iktalic {Tru... (TrueTwvpe) (TrueTwpe) (TrueTwpe) (TrueTwpe) Bold (Tru... Bold Ikali... Condens. ..
Gill Sans MT Gill Sans MT  Gill Sans Ulkra  Gill Sans Ulkra Global Global Sans Global Serif Global User  Gloucester MT Goudy Cild
Ext Cond... Italic (Tr Bold (True... Bold Cond... Monospace Serif Interface Extra Cond... Skvle (Tr...
Goudy Qld Goudy Cld Goudy Stout Haettensch... Hobostd IDAutomati. .. Impack Imprinkt MT Kartika KozGoPro-Bold
Skyle Bol. .. Skyle Ika., ., (TrueTwvpe) (TrueTwvpe) (TrueTwpe) (CpenType) eTvpe) Shadows ... (TrueTvpe) (TrueType)
kKozGoPro-E... KozGoPro-H... KoziGoPro-Li... KozGoPro-M... KozGoPro-R... kozMinPro-... kKozMinPro-... KozMinPro-... KozMinPro-...
(TrueTwpel (TrueTwpe) (TrueTwpe) (TrueTwvpe) (TrueTwpe) (TrueTwpe) (TrueTwpe) (TrueTwpe) (TrueTwpe)
kozMinPro-. .. Latha LetterGothi... Lektercobhi... LetkerGothi... LekkerGothi... LithosPro-B...  LithosPro-R... Lucida Cosgole Lucida Sans
(TrueTvpe) (TrueType) (TrueTvpe) (TrueTvpe) (TrueTvpe) (TrueTwvpe) (TrueTvpe) (TrueTvpe) (TrueTvpe Deribaold IE. ..

o] O

Lucida Sans Lucida Sans
Demibold. .. Italic {Tr...

o)

Lucida Sans
Regular ...

o)

Lucida Sans
Twpewrik. ..

o)

Lucida Sans
Tywpewrit. ..

o)

Lucida Sans
Twpewrit. ..

o)

Lucida Sans
Twpewrit, ..

o)

Lucida Sans
Unicode ...

Maiandra 5D
(TrueTvpe)

MMarngal
[TrueType)

The font IDAutomationHC39M _FREE.otf needs to be in the C:\WINDOWS\Fonts
directory -- you may get a warning message when you click on the Windows folder
But this is where the fonts need to live.




Not Necessary But If It Bothers YOU

Column A doesn’t look like my barcodes --

Can we get rid of the barcode numbers in column A since they are printed with the
barcode?

Does the library code do anything?



This Doesn’t Look Like My Barcode!

Microsoft Excel - Print_User_Barcodesl i [=]
@J File Edit Wiew Insert Format Tools Data  Window Help Type a question for help » _ & =
DEHRISRITE %R F9-™- (= -4] %] [ - @ g ¢ cambria -0 -|B 7 Uu|=E==HES-A-F
d &8 28 Py A Reply with Changes... End Review. .. B
Open In Contribute La Publish To Website Post To Blog E @Convert FOF ﬁCreate FDF l_@ Eﬂ E
mnxlap

Al - A 24028000056063
B | c | b | E | F & H i I K L =

‘I‘II Q29 3030 & 40 & F
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”Il || ||!|||2|||J||!|||!I|!|||llljll !“!mlll” Il
3 24029E+13|TOOELEEEM AMNDERSONM,. GAGE L.

‘Ill || ||J|J|J|J|J|u||u||e|| !"JL"J‘ Il
4 | 24029E+13|TOOELEEEM AMDERSONM, JOSHUA L.

‘lll || ||!'||2|||J||‘I_‘||!I|!'||‘I_‘||d||| !lllll!ll!” ll
5 | 24029E+13|TOOELEEKM AMDERSOM, KEMIMEDIE

AT
[a] 24029E+13|TOOELEEEN ANDERSOM, OAKLEY D.

4 4 b M[iSheetl { Gheetz £ Sheets 7 |« | L[J_I
Draw ~ g | AutoShapes = ™ ™ [] O 2] ‘-‘ﬂ{:? 8] [ &‘ﬁ'é'E
Ready Sum=4.52953E+15 ML o

Highlight the column (place cursor over the “A” until it turns into a down arrow,
then right click) go to Format>Cells



How I Want My Number to Look

2 x|

Murmber I Alignmenk I Fonk I Border I Pakkterns I FProtection I
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|GE:nE:raI - I Z40Z290000565053

CUrrency T Cecimal places: Iﬁ
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Percentage Megative numbers:

Fracktion =g '

Scientific

Texk 1254

Special (1234

Custom =1 {1254) =1

Murmber is used|For general displaw of nummbers, Currency and Accounkting
offer specialized Formatking For monetary walue,

(] o _I Cancel
~—

/
Choose “Number” and set Decimal places to “0” then click on “OK”




I Can Read Them .. But I’ll Let the Scanner Do It

Microsoft Excel - Print_User_Barcodesl i [=]
Eﬂ File Edit Wiew Insert Format Tools Data  Window Help Type a question for help « _ &
DEFEHRERIVE XBERF9-C 8= @i s Bz u|SS=EE A
d &8 28 Py ¥ | ) | Reply with Changes... End Review. .. B
Open In Contribute Publish To Website Post To Blog E @Convert FOF ﬁCreate FDF l_@ Eﬂ E
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4 4 ¢ M[.Sheetl { Gheetz £ Sheets 7 |« | L[J_I
Draw = g | Autoshapes~ > [ O A Al ¢F B8] (& & - - A - = Eﬂ.jﬂ

Ready MU

Now we have a column with human readable numbers and a column with a barcode — do we need

both? --- hmm ....




Formulas and Values

[E Microsoft Excel - Print_User_Barcodes1 - O] =|
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DEHR GRS H | 4 2R - - @ E -4 %) (i [aB] oo v @ |J  mautomationHcIsM < & < | B 1 U SBEEEIE: >-A-H
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Open In Conkribute ﬁ Publish Ta Website Post To Blog H @Convert FDF "ﬂ Create PDF l_,ﬁ Eﬂ H
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4 | 24029E+13 TOOELEBEM AMDERSONM, [OSHUA L.
|_II!l_ll!I!I!l!l!l!l!l!l!l!lslll‘_l
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Ready MU o

Remember the formula bar -- as long as our column is using a formula to pull the
barcode number into the new column we have to have both, so ... if you highlight
column D




From Formula to Value

1 | A d - LW &3 Y Feply with Changes... End Rewview... B

Microsoft Excel - Copy of willowelem1skt.xls — 8] =]
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Highlight the barcode column .. “copy” the column and then go to “Edit” on the
menu bar and choose “Paste Special” ...



Paste Special Choices

3
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Change the “Paste” radio button from “All” to “Values”
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Faste
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And click on OK




MAGIC!
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Our formula bar now shows the barcode number not the formula so if we want we can
remove column A ... and column B since there is not individual information in that

column

IF YOU HAVE QUESTIONS CALL - 801-715-6758 (RAH’s #)
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